Supplement:

Corporations

(1120)
Copyright

The 2017 Drake Tax User’s Manual Supplement: Corporations, Drake Tax Software, and any other related materials are copyrighted material. All rights are reserved by Drake Enterprises, LTD, including all ownership rights. This document, associated software, and related material are the property of Drake Enterprises, LTD.

Drake Enterprises, LTD, hereby authorizes you to download, display, print, and reproduce the material in this document in an unaltered form only for your personal, non-commercial use or for non-commercial use within your organization. Copyright, trademark, and other proprietary notices may not be removed.

© 2017 Drake Enterprises, LTD. All rights reserved.

While every attempt has been made to produce an accurate and complete manual, there is no warranty, expressed or implied, to that effect. Drake Enterprises, LTD, assumes no liability for damages or claims resulting from the use of the information contained herein.

Trademarks

The Drake Software Logo and Drake Tax are registered trademarks of Drake Enterprises, LTD.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.

Other product names mentioned in this manual may be trademarks or registered trademarks of their respective companies.
# Table of Contents

What’s New in Drake Tax for Corporations ................................................. 9  
Data Entry Streamlined for Group and Installment Sales .......................... 9  
“Doing Business As” .............................................................................. 10  
Name Control Override ......................................................................... 10  
Practice Management Tools ................................................................... 10  
Before You Start ..................................................................................... 10  
Updating a Prior-Year Return in Drake Tax ........................................... 10  
Converting from Another Return Type .................................................... 11  
Filing Form 1120-C or 1120-H ................................................................. 11  
Header Information ................................................................................ 11  
Name and Address .................................................................................. 12  
Tax Year .................................................................................................. 12  
Boxes A through E .................................................................................. 13  
Optional (but Recommended) Security Information .................................. 13  
Income and Deductions ......................................................................... 14  
Gross Receipts ....................................................................................... 14  
Cost of Goods Sold (Form 1125-A) .......................................................... 14  
Dividends (Schedule C) ......................................................................... 15  
Interest .................................................................................................... 16  
Rents and Royalties ................................................................................ 16  
Capital Gains ........................................................................................... 16  
Ordinary Gains and Losses .................................................................... 16  
Other Income (Loss) .............................................................................. 16  
Compensation of Officers (Form 1125-E) ............................................... 17  
Salaries and Wages ............................................................................... 18  
Repairs and Maintenance ...................................................................... 18  
Bad Debts ............................................................................................... 18  
Rents ........................................................................................................ 18  
Taxes and Licenses ................................................................................ 19  
Interest Expense .................................................................................... 19  
Charitable Contributions ....................................................................... 19  
Depreciation ......................................................................................... 20  
Depletion ................................................................................................. 20  
Advertising ............................................................................................. 20  
Pension and Profit-Sharing .................................................................... 21  
Employee Benefit .................................................................................. 21  
Domestic Production Activities ............................................................... 21  
Other Deductions .................................................................................. 21  
NOL Carrybacks and Carryforwards ....................................................... 21  
Tax, Refundable Credits, and Payments ................................................ 22  
Total Tax ................................................................................................ 22  
Form 3800 .............................................................................................. 22  
Estimated Taxes and Applied Refunds .................................................... 23  
Estimated State Taxes .......................................................................... 24
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Types of Returns</td>
<td>47</td>
</tr>
<tr>
<td>Electing a 52-53–Week Year (Initial Return)</td>
<td>48</td>
</tr>
<tr>
<td>Inactive Returns</td>
<td>49</td>
</tr>
<tr>
<td>Foreign Tab.</td>
<td>49</td>
</tr>
<tr>
<td>Binary Attachments</td>
<td>49</td>
</tr>
<tr>
<td>The PDF Attachment Process</td>
<td>49</td>
</tr>
<tr>
<td>Form 3115, Application for Change in Accounting Method</td>
<td>52</td>
</tr>
<tr>
<td>Accessing Screens for Changing Accounting Method</td>
<td>52</td>
</tr>
<tr>
<td>Form 3115 Screens</td>
<td>53</td>
</tr>
<tr>
<td>Importing Trial Balance Information</td>
<td>54</td>
</tr>
<tr>
<td>Preparing to Use Trial Balance Import</td>
<td>54</td>
</tr>
<tr>
<td>Preparing Financial Data for Import</td>
<td>56</td>
</tr>
<tr>
<td>Entering Financial Data</td>
<td>57</td>
</tr>
<tr>
<td>Saving a File</td>
<td>59</td>
</tr>
<tr>
<td>Importing Data into a Return</td>
<td>59</td>
</tr>
<tr>
<td>Special Conditions</td>
<td>60</td>
</tr>
<tr>
<td>“EF Notice” Page</td>
<td>63</td>
</tr>
</tbody>
</table>

**Appendix A: Trial Balance Import** ......................................................... A-1

**Index......................................................................................................... lxv**
This page intentionally left blank.
Corporations (1120)

The basics of data entry for a corporation (1120, 1120-C, 1120-H) return are the same as for a 1040 return. Navigation through data entry, field- and screen-level help, and keyboard shortcuts all function as they do in the 1040 program. See the 2017 Drake Tax User’s Manual for the basics of using the program. (The manual is available on the installation CD and on the Drake Support website: Support.DrakeSoftware.com > Training Tools > Manuals.)

What’s New in Drake Tax for Corporations

Drake Tax is programed to conform to the latest IRS rules and regulations. The 2017 program reflects all changes to forms, credits, and deductions. For details on the new regulations for the 2017 tax year, see the IRS instructions for Form 1120.

The following changes have been made to the 1120 program in Drake Tax for the 2017 tax year.

Data Entry Streamlined for Group and Installment Sales

One of the biggest changes in Drake Tax this year is in how the program treats installment sales and group sales of assets.

Much of the information needed on Form 6252, Installment Sale Income, now flows to the form from screen 4562 or screen 4797. The program then completes Forms 6252 automatically (unless you tell it not to).

Use an Installment Sale MFC (multi-form code) to tie an installment sale of an asset to a specific Form 6252, entering the data only once, on a screen 4562 or screen 4797.

For multi-asset sales (“group” sales), you can enter a Group sale number. Similar to MFCs, group sale numbers link all like-numbered items in one sale.

Another addition is the new Date taken out of service field on screen 4562. An entry in this field stops calculation of depreciation on the asset.
For more on these features, see the following chapters in the 2017 Drake Tax User’s Manual:

- For how multi-form codes work, see “Associating On Screen with Another” in Chapter 3.
- For more on completing data entry for installment sales and group sales, see “Reporting Installment Sales” in Chapter 5.
- For more on reporting asset depreciation with screen 4562, see “Completing Form 4562, Depreciation and Amortization” in Chapter 5.

“Doing Business As”

We moved the DBA field and enhanced the program so that whatever is entered in the DBA field of screen 1 will now be printed below the legal name of the corporation in the “Name” section of the main form (and on certain other forms).

See “Doing Business As” on page 12 for more.

Name Control Override

An Entity Name Control override field was added to the EF screen (available from the General tab of the Data Entry Menu). This override field can be used if the Name Control is obtained from the IRS’s Business & Specialty help line.

IMPORTANT

The Entity Name Control override field should be used only when directed by the IRS or Drake Software Support. See the field help for the Entity Name Control field for more information.

Practice Management Tools

For details on additions and enhancements to Drake Tax’s practice management tools—such as the ability to retrieve forgotten passwords, an expanded search feature that finds phrases or words across a return, and the new SecureFilePro Connect service—see Chapter 1, “Introduction,” of the 2017 Drake Tax User’s Manual.

Before You Start

Actions you might need to take before starting a 2017 corporation return in Drake Tax include:

- Updating a prior-year return (if you prepared the tax return last year in Drake Tax)
- Changing a return from another type of return to an 1120, if the corporation has made such a change in the last year

Updating a Prior-Year Return in Drake Tax

A prior-year return can be updated in one of three ways:
• As a single return (updated one at a time) using Last Year Data > Update Clients 2016 to 2017 (recommended)
• When you open a 2016 return for the first time in the 2017 program and are prompted to update it
• With all other returns in the program using Last Year Data > Update Clients 2016 to 2017 (not recommended)

When you update an 1120 return that was marked “final” the previous year, the program informs you that the return was marked final before prompting you to proceed.

**Converting from Another Return Type**

If the corporation is electing to become an 1120 corporation after existing as another type of entity (S corporation, partnership, etc.), it is necessary to indicate this in the program.

To change from another type of entity to an 1120 corporation in Drake Tax:

1. From the Home window menu bar, select Tools > File Maintenance > Change File Type.
2. Enter the EIN of the entity and click Continue.
3. Select the new return type.
4. Click Continue to save the change, then click OK.

**Filing Form 1120-C or 1120-H**

No preliminary steps are required for completing Forms 1120-H or 1120-C. Use the same screens you might for an 1120 return, but include one of the following screens in addition (accessible from the first Other Forms tab of the Data Entry Menu):

- **H** — For Form 1120-H, U.S. Income Tax Return for Homeowners Associations
- **20C** — For Form 1120-C, U.S. Income Tax Return for Cooperative Associations

If one of these screens contains data, the program automatically produces the type of return indicated. For example, if a deduction is entered on screen 20C, an 1120-C return will be produced.

**Tip**

Is Form 1120-C or 1120-H being produced in error? Check the corresponding screen (H or 20C) for data entered. To delete a screen, open the screen and press CTRL+D, right-click the screen and select Delete Screen, or from the data entry screen toolbar, select Delete.

**Header Information**

Screen 1 contains fields for the general information printed in the top section of page 1 of Form 1120 (or Form 1120-C or 1120-H, as applicable).
Name and Address

Use screen 1 to enter the corporation’s name and address for Form 1120. For state purposes, if the corporation has an alternate address (such as a P.O. box), you can enter that address on screen 2, State General Information, in the Address Line 2 field at the bottom of the screen.

NOTE
The screen 2 link is located on the States tab of the Data Entry Menu and on screen 1. You can also type 2 into the selector field and press Enter.

Doing Business As

The Name and Address Information section of screen 1 of the Corporation package has been modified slightly. We moved the DBA field up and enhanced the program so that whatever is entered in the DBA field of screen 1 will now be printed below the legal name of the corporation in the “Name” section of the main form (and on certain other forms, such as Form 8821, Tax Information Authorization, and Form 2848, Power of Attorney).

Use of the DBA field is optional and data entered there is not required by the IRS. It is provided in the program for the return preparer’s convenience.

Continuation Line

The DBA field on screen 1 can also serve as a “continuation” line for entity names that are too long to fit into the legal name field. Be aware, however, that not all federal forms accept data from a continuation (or DBA) line. For those forms, only the data entered in the legal name field is used.

NOTE
Not all states recognize the use of a DBA. Those state packages ignore data entered in the DBA field.

Tax Year

The program uses the calendar year as the default tax period for all corporation returns; no date entries are required on screen 1 for a December 31 tax year end.

Fiscal and Calendar Years

If the corporation uses a fiscal year (where the year begins in the current calendar year and ends in the next), specify the beginning and ending dates in the If not calendar year section in the lower left corner of screen 1.

NOTE
The program adjusts calculations for depreciation and for gains and losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53–week year, see “Electing a 52-53–Week Year (Initial Return)” on page 47.

Short-Year Returns

A corporation might have to file a short-year return if it is changing accounting periods with IRS approval (Form 3115), or if this is its first or last year in business and the tax year is not a full year.

Short-year return election information and 52-53-week tax year information is entered on the Year screen, available on the Miscellaneous tab of the Data Entry Menu or...
from a **Year** link on screen 1. (Certain other elections are made from the **ELEC** screen.)

To enter short-year election information:

1. Enter short-year dates on screen 1 in the **Fiscal year begins** and **Fiscal year ends** fields, even if the firm uses the calendar year for full-year returns. These dates will appear on the top of the federal form.
2. Click the **Year** link to open the **Year** screen.
3. Make your short-year selection from the **Other short-year reason** drop list. Your explanation is displayed at the top of the first page of the tax return. If you do not select an explanation, an EF Message is generated with the return, and the return cannot be e-filed.

If you selected “09 General Explanation” from the **Other short-year reason** drop list, type details on the reasons for filing a short-year return in the **Explanation** text box; otherwise, an EF Message is generated.

For more information on short-year explanations, see IRS Pub. 4163.

The program may not correctly calculate depreciation, gains, or losses for a short-year return. Depreciation for a short-year return can be entered on screen 4562 and screens 6, 7, 8, and 9.

### Boxes A through E

Use screen 1 to enter most information for boxes A through E (top of Form 1120). Note that boxes A-4 (“Schedule M-3 attached”) and D (“Total assets”) are completed automatically by the program based on data entered elsewhere.

Box 1a (“Consolidated return”) in section “A” is automatically marked if there are entries on screen 851 (Form 851, Affiliations Schedule).

Box 2 (“Personal holding company”) in section “A” is automatically marked if there are entries on screen PH (Schedule PH, U.S. Personal Holding Company (PHC) Tax).

### Optional (but Recommended) Security Information

The **Filing Security Information** screen in Drake Tax is part of an industry-wide initiative to better protect taxpayers and return preparers from data theft and tax fraud. The information entered on the **SEC** screen is transmitted when the tax return is e-filed. Completing this screen for federal returns is strictly optional for 2017; however, certain states will begin requiring this information in the near future.

The Filing Security Information (**SEC**) screen is accessible through the **Filing Security Information** link on screen 1 or from the **Data Entry Menu**.
Income and Deductions

Only three screens are required in order to calculate taxable income for an 1120 return:

- **INC** — Includes all items of income reported on Form 1120, page 1, lines 1 through 10, that do not require a separate schedule (Schedule C) or additional information (income reported on Form 1065, Schedule K-1); also includes tax-exempt interest income reported on Schedule K and Schedule M-1.

- **DED** — Includes all deduction items reported on Form 1120, page 1, lines 13 through 26, that do not require a separate schedule or form (Form 4562). (Data for line 12 of the 1120, “Compensation of officers,” is generally entered on screen **DED** when Form 1125-E is not required; otherwise, it’s entered on screen **E**. See “Compensation of Officers (Form 1125-E)” on page 17 for details.)

- **J** — Includes loss carrybacks, controlled group tax bracket amounts, tax payment information, and certain credits.

Gross Receipts

Enter gross receipts (Form 1120, line 1a) and returns and allowances (Form 1120, line 1b) on lines 1a and 1b of the **INC** screen. Exclude any amounts that are to be reported on lines 4 through 10 of Form 1120.

Cost of Goods Sold (Form 1125-A)

Enter the cost of goods sold (COGS) on screen **A**. Form 1125-A is not produced unless entries are made on screen **A**.

**Inventory**

Inventory amounts entered on lines 1 and 7 of screen **A** automatically flow to Schedule L, line 3 (“Inventories”)

Lines 1, 2, and 7 of screen **A** are adjustment fields. Amounts entered in these fields adjust (add to or subtract from) any amount flowing from the **F** screen (Form 1040, Schedule F, Profit or Loss from Farming) to line 2 of Form 1120.

On both of the Schedule L screens – **L** and **L2** – line 3, “Inventories,” is an override field. Anything entered in these fields overrides (replaces) the total calculated from inventory data entered on screen **A**.

**Line 5, Other Costs**

Line 5, “Other costs,” on screen **A** is designated for any applicable costs not entered on lines 2 through 4 (purchases, cost of labor, and additional section 263A costs). In Drake Tax, two data-entry fields are used to complete line 5: one for other costs excluding depreciation, and one for depreciation (Figure 1 on page 15).
In the “Depreciation” field, enter any depreciation that relates to the cost of goods sold (unless the amount is flowing from the 4562 screen with COGS selected from the For drop list). Note that this field of screen A is an override field; an entry here overrides calculations from the 4562 screen and automatically adjusts the total depreciation that flows to page 1 of Form 1120. An entry in the “Other costs - excluding depreciation” field opens a Detail Worksheet (also known as a CTRL+W worksheet). The program automatically generates a worksheet if an entry is made here or in any other field where a worksheet is required by the IRS. The depreciation amount is included on the statement for other costs and should not be included in the “Other costs - excluding depreciation” field.

If using the trial balance import feature (see “Importing Trial Balance Information” on page 53), enter depreciation amounts directly into the appropriate fields on the trial balance worksheet, not in the fields in data entry. When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Form 1125-A and is calculated accordingly.

**Dividends (Schedule C)**

Enter dividends and special deductions on screen C (Schedule C). The Dividends Received Deduction Worksheet (Wks DRD) is generated from data entered in these fields. The result of the Wks DRD is carried to Schedule C of the return. The total from Schedule C, line 19, column (a), is carried to Form 1120, line 4 (“Dividends”), and the total from Schedule C, line 20, column (c), is carried to Form 1120, line 29b (“Special deductions”).

**NOTE** If the corporation is filing a consolidated return, do not enter non-included dividends here or anywhere else in the program.
Interest

Line 5 of Form 1120 is for interest income, which is entered on the INC screen. Note that the Interest income field is an adjustment field; an amount entered there is combined with the interest amount, if any, entered on screen 6252 (Form 6252, Installment Sale Income) and interest income entered on screen K1P (Schedule K-1, Form 1065).

Enter tax-exempt interest income on the INC screen. This amount flows, as applicable, to Schedule K, line 9, and to Schedule M-1, line 7. An override field is available on screens K if necessary to override the INC screen amount and any amount flowing from screen K1P, line 18, code “A.”

Rents and Royalties

Enter gross rents and gross royalties using the direct-entry fields on the INC screen. Line 7, “Gross royalties” is an adjustment field. Any amount entered here adjusts amounts flowing from line 7 of screen K1P.

Note that passive activity loss rules may be applied to rental activities held by a closely held corporation or a personal service corporation.

Capital Gains

Screen code: 8949
Use screen 8949 to enter capital gains and losses. Short-term capital gains flow to Part I, lines 1b, of Schedule D. Long-term capital gains flow to Part II, lines 8b-9, of Schedule D. The net gain from Schedule D is carried to line 8 of Form 1120. (Any net capital loss is carried to Attachment D to offset future gains.)

NOTE
You can import data for Schedule D using the Form 8949 Import feature. For more on using this feature, see “Form 8949 Imports” in Chapter 5 of the 2017 Drake Tax User’s Manual.

Ordinary Gains and Losses

The amount generated for line 9 flows from Form 4797, Part II, line 17. Amounts can also flow from screen 4562 to Form 4797 (making screen 4797 entries unnecessary), but only if screen 4562 shows assets sold, date, and property type.

Other Income (Loss)

Use the INC screen to enter amounts for the “Other income” line of the main form. Specific INC screen entries are displayed on attached statements in View/Print mode.

For Form 1120, calculated amounts from the following screens also flow automatically to “Other income” (line 10):

- Screen 6478 (Form 6478, Biofuel Producer Credit)
- Screen 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields for other income on the INC screen include:
- Amount of credit for tax on fuels
- Interest income on receivables
- Recoveries of bad debts
- Section 481 adjustments
- State tax refund
- Taxable income from insurance proceeds
- Other (itemize) (Detail worksheet is required.)

**NOTE**

Data from Schedules K-1 received from partnerships should be entered on the K1P screen (located on the first Other Forms tab of the Data Entry Menu).

**Compensation of Officers (Form 1125-E)**

Form 1125-E, Compensation of Officers, is not generated automatically with the return unless it is required—in other words, unless total receipts (line 1a, plus lines 4 through 10) on Form 1120 are $500,000 or more. To force the program to print Form 1125-E, from the PRNT screen, select **Force Form 1125-E, Officer Compensation**.

**Officer Information**

Use screen E to enter officer information and compensation amounts. Press PAGE DOWN to enter additional officers. Screen E totals are calculated and carried to line 12 of Form 1120.

The total of officer compensation can be entered in the **Officer compensation** override field on the DED screen (generally used when Form 1125-E is not required). An entry in that field overrides any calculations from screen E, changing lines 12 and 27 of Form 1120, but it does not change the numbers on Form 1125-E.

**TIP**

You may “truncate” the officer’s Social Security Number in the ID number field of screen E. To do so, enter five zeros (“0”) and then the last four digits of the SSN. You must press CTRL+F to “force” the program to accept the truncated number.

**IMPORTANT**

Neither “FOREIGNUS” nor “APPLD FOR” is acceptable in the ID number field. Returns with “FOREIGNUS” or “APPLD FOR” in this field are not eligible for e-file.

**Screen E Check Boxes**

Screen E has two check boxes: **Signs return** and **Books in care of**. Mark the applicable box on the screen that identifies the officer who either signs the federal or state paper returns or is the contact person for the books (state return only).

**Ownership & Participation**

The Ownership and Participation fields on screen E are required. Fields are as follows:

- **Total** — Enter the officer’s ownership percentage.
- **Common** — Enter the percentage of common stock owned by the officer.
- **Preferred** — Enter the percentage of preferred stock owned by the officer.
- **Time** — Enter the percentage of time the officer devotes to the corporation.
Enter percentage amounts in whole numbers. For example, enter 40 for 40%

**Salaries and Wages**

Use the **DED** screen to enter salaries and wages paid. Note that the **DED** screen amount is reduced by the amount, if any, of credit from Form 5884. Also note that the “Salaries and wages” field on the **DED** screen is an adjustment field; an amount entered here adjusts any amount entered on screen **F** (Form 1040, Schedule F, Profit and Loss from Farming) in the “Labor hired” field.

*NOTE*

The “Salaries and wages” amount should *not* include compensation of officers. Enter officer compensation data either on screen **E** or as “Officer Compensation” on line 12 of the **DED** screen.

**Repairs and Maintenance**

Enter repair and maintenance costs on the **DED** screen. An amount entered here is combined with the amount, if any, entered in the Repairs and maintenance field on screen **F**.

**Bad Debts**

Use the “Bad debts” line on the **DED** screen to enter the total debts that became worthless in whole or in part during the year, but only to the extent that such debts related to a trade or business activity

*NOTE*

Enter deductible non-business bad debts as a short-term capital loss on screen 8949 (*Capital Gains & Losses*).
Cash method corporations cannot take a bad debt as a deduction unless the amount was previously included in income.

**Rents**

Use the **DED** screen to enter rent paid on business property used for a trade or business activity. If the corporation rented or leased a vehicle, enter the total annual rent or lease expense incurred in the trade or business activity of the entity, and then complete Part V of the 4562 (screens 8 and 9).

*NOTE*

The Rents field is an adjustment field. An amount entered here is combined with the amount, if any, entered in the Rent fields on screen **F**, lines 24A and 24b.
Taxes and Licenses

Enter tax and license amounts in the Taxes and licenses section of the DED screen. Click the Detail link to list the various sources of taxes and licenses. Amounts are combined and the sum generated on Form 1120, line 17 (“Taxes and licenses”).

These amounts also appear on the Taxes and Licenses Attachment (“Wks Tax/Lic”). To keep the notification from appearing, go to the PRNT screen (accessible from the General and the Miscellaneous tabs of the Data Entry Menu) and select Suppress printing form and attachment references.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes) screen are carried to the tax computation worksheet (Form 1120-W). The state tax amount carried from the ES screen may differ depending on which method of accounting (cash or accrual) is used.

Interest Expense

Enter interest expense on the DED screen. Note that the Interest expense field is an adjustment field. Any amount entered here is combined with the amount, if any, entered in the Interest fields on screen F.

Charitable Contributions

The DED screen provides two fields for entering data for line 19, “Charitable contributions” (Figure 2).

![Figure 2: Charitable contribution lines on the DED screen](image)

- **Contributions** — Enter the gross amount of contributions for the year that are subject to the 10% limit on deduction.
- **Qualified conservation contributions** — Enter the gross amount of contributions for the year that are not subject to the 10% limit. These contributions have a carryover period of 15 years; see IRS instructions for details.

The program calculates the contributions allowed and determines carryover capability for amounts entered in both fields for line 19 and reflects the applicable amount on Form 1120. (Refer to the Contribution Limitation/Carryover Worksheet (“Wks Contrib”) for calculation of allowed amount.) Contribution carryovers from prior years are entered on the LOSS screen.
Note that both fields of line 19 are adjustment fields; entries here adjust amounts flowing from screen **K1P**, line 13, codes **A** and **B**.

**NEW FOR 2017**

A 100% deduction for qualified hurricane relief contributions is available for the 2017 tax year. See the field on the **DED** screen, and the field help for details.

**Depreciation**

Enter depreciation on the **4562** screen. Select a form from the **For** drop list (Figure 3) to associate the depreciable item with the correct form or activity. Data from the **4562** screens flows to Form 1120 and to the selected schedules or forms.

![Figure 3: Selecting “1120” from the **For** drop list of the **4562** screen](image)

**NOTE**

For more on the **For** drop list in Drake Tax, see “Associating One Screen with Another,” in Chapter 3 of the **2017 Drake Tax User’s Manual**.

**Depletion**

Enter depletion deductions on the **DED** screen. See Form 1120 instructions and Pub. 535 for more information on depletion.

**Oil and Gas Depletion Worksheet**

The **DEPL** screen is accessible from the first **Other Forms** tab of the **Data Entry Menu**. Create a separate depletion worksheet for each oil or gas interest. (Press **PAGE DOWN** to open a fresh instance of the **DEPL** screen.) Enter data for cost depletion, percentage depletion, or for both. If data for both cost and percentage depletion is entered, the program does both computations and sends the one that gives the corporation the best deduction to the proper form or schedule. (Not all corporations have the option of using either method. Consult Publication 535 for additional information.)

Entries on the **DEPL** screen flow to the Oil and Gas Depletion Worksheet (“Wks DEPL”) in View mode.

**Advertising**

Enter advertising expenses on the **DED** screen.
Pension and Profit-Sharing

The program reduces this expense based on the credit amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup Costs.

Employee Benefit

Contributions to employee benefit programs not claimed elsewhere on the return that are not an incidental part of any plans are entered in an adjustment field on the DED screen. An amount entered on this field adjusts the amount being carried from Schedule F, Profit or Loss from Farming.

Domestic Production Activities

Click the 8903 link on screen DED. Use screen 8903 to complete Form 8903, Domestic Production Activities Deduction (DPAD). The calculated total of screen 8903 flows to line 25 of Form 1120.

NOTE

The DPAD is not allowed on returns with a net operating loss (NOL) for the current year. It also cannot be used to create a current-year loss.

Other Deductions

Enter all other deductions on the DED screen. The program calculates these amounts and incorporates the total into line 26 (“Other deductions”) of Form 1120. The following deductions, credits, adjustments, and exclusions also flow to line 26:

• Amortization from Form 4562
• Credit from Form 8820, Orphan Drug Credit
• Exclusion from Form 8873, Extraterritorial Income Exclusion
• Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

NOTES

Drake Tax automatically calculates meals and entertainment limitations.

A Detail Worksheet is opened when you type an amount in the “Other (itemize)” field.

NOL Carrybacks and Carryforwards

Enter NOL carrybacks from future years to the current year on screen J (Loss Carryback, Tax Computation, Payments). To enter multiple carryback amounts, double-click in the field to open a Detail Worksheet.

Use the LOSS screen to enter NOL carryforwards, capital losses, and contribution carryforwards from prior years. Use screen J to enter current-year carrybacks to prior years.
Tax, Refundable Credits, and Payments

Screen J has fields for completing the “Tax, Refundable Credits, and Payments” section of Form 1120. Note that some fields are overrides. Press F1 to view more information on a field.

Total Tax

For corporations that belong to a controlled group, complete all applicable fields on screen J. If allocating income to the various brackets on this screen, you must enter 0 (zero) in the fields of the brackets to which no income is allocated.

The total tax from Schedule J is calculated and carried to line 31 of Form 1120.

Controlled groups are also required to complete Schedule O. Use the O screen in Drake Tax to complete Schedule O. (Screens O and OM are available from the first Other Forms tab of the Data Entry Menu. The Sch O Screen link on screen J opens the OM screen; from the OM screen, press PAGE DOWN to open screen O.)

See “Schedule O (Controlled Group Information)” on page 40.

Form 3800

Use screen 3800 to claim current-year business credits that are not supported by Drake Tax.

Screen code: 3800

In Part III - General Business Credits, enter the amounts of nonpassive and passive activities of the unsupported credits.

Returns with these current-year credit forms that are not supported by Drake Tax must be paper-filed.

Pass-through credits from those unsupported forms are supported by Drake Tax. Enter these pass-through credits on screen K1P. Enter carryforwards on screen GBC.

To enter data for credits that are supported by Drake Tax, use the credit's screen. For example, use the 8820 screen for Form 8820, Orphan Drug Credit.

Enter any unused current-year credit being carried back and used in 2016 in the Amount of Carryback text box on screen 3800.

Screen code: GBC

Use screen GBC for reporting general business credit (GBC) and eligible small business credit (ESBC) carrybacks and carryforwards, and to enter passive activity credit carryforwards for Form 8582-CR.

Passive activities credit carryforwards are updated to screen GBC.

To use the GBC screen:

1. Mark an appropriate check box at the top of screen GBC.
2. If appropriate, enter an EIN in the **Activity EIN** field; if that EIN matches one entered on a K1 screen, the program matches the passive activity carryforward to the current-year credit for Form 8582-CR.

3. Enter the **Activity Name**.

4. From the **Description of credit** drop list, select the description of the credit for the amounts being carried forward from prior years or being carried back from a future year. If necessary, enter the **Amount Changed Information** if the amount changed from the original amount of the credit.

5. From the **Year Originated** drop list, select the year the credit was originally generated and the amount of the credit for the year generated.

Press PAGE DOWN to enter the carryforward or carryback amounts of another credit.

**TIP**

In the **Amount of Original Credit Previously Used** section of screen GBC, type in the amounts of credit carryforward used in a previous year for a true historical record. The program computes the remaining amount of the credit each year you use Drake Tax.

### Estimated Taxes and Applied Refunds

**Screen code: ES**

Enter on screen ES (available on the **Miscellaneous** tab) the estimated corporation taxes paid. If necessary, use screen W to override 2017 estimated taxes paid and apply any overpayments from 2017 to 2018. (Click the Screen W link at the top of the ES screen to open the W screen.)

**NOTE**

Estimate vouchers are not used in federal corporation tax returns.

**Overpayment**

Overpayments are not automatically applied unless 2018 estimates are being calculated. If no estimates are required, enter the application of the overpayment using the **Overpayment applied** override fields.

**Quick Refund**

To file Form 4466, Corporation Application for Quick Refund of Overpayment of Estimated Tax, go to the PRNT screen (accessible from the **General** and the **Miscellaneous** tabs of the Data Entry Menu) and mark the **Calculate Form 4466** box. This is the only entry necessary to produce the form. (There is also a link to the PRNT screen from the first **Other Forms** tab of the Data Entry Menu. Click 4466 Application for Quick Refund.)

**Underpayment**

Use screen 2220 to enter information for Form 2220, Underpayment of Estimated Tax by Corporations. Note that the 2220 screen in Drake Tax consists of two screens. Press PAGE UP and PAGE DOWN to move back and forth between the screens.

**NOTE**

The program retains the underpayment and penalty rates as of 12/31 of the calendar year.
Estimated State Taxes

Enter 2017 estimates and 2018 overpayments for state returns on the ES screen.

The ES screen also provides a way to e-file state estimated tax vouchers and payments, which is required in some states. For estimated taxes from multiple states or cities, press PAGE DOWN and go to a new ES screen.

For details on using the ES screen to file federal estimated taxes, and to e-file and pay state estimated taxes, see “Estimated Taxes,” in Chapter 5 of the 2017 Drake Tax User’s Manual.

NOTES

If you are not filing four quarterly state vouchers—for instance, if filing too late to pay first quarter payment—the program adds the amount of the missed payment to the next available voucher. Enter “0” in the Estimate amount voucher field for the quarter the payment was not made.

The Increase/Decrease calculated estimates by... text box on the ES screen allows you to adjust the total estimated taxes due.

Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submitted with an e-filed return in order for a corporation’s refund to be direct-deposited. To access this form in Drake Tax, go to the DD screen, accessible from the General tab of the Data Entry Menu.

When filling out the DD screen:

- If the federal refund is to go to the account listed, select Yes for the Federal selection drop list; otherwise, select No. (Default is Yes.)
- If a state refund is to go to the account listed, select the state abbreviation from the State/city selection drop list.
- Enter the name of the financial institution, the routing number (RTN), the account number, and the type of account (Checking or Savings).
- Re-enter the routing number, account number, and type of account to verify (Figure 4).

![Account Information](image)

**Figure 4**: Federal section of DD screen (also 8050 screen)

If receiving refunds from different state tax authorities, use the State Account boxes on the DD screen to indicate where other state refunds should be deposited.
Electronic Funds Withdrawal (Direct Debit)

Use the PMT screen, accessible from the General tab, to indicate that the balance due for an e-filed return should be withdrawn (direct-debited) from an account.

Program Defaults and Overrides

By default, the program indicates that the entire balance due (line 34, “Amount owed”) is to be withdrawn on the return due date. To indicate otherwise, complete the Requested payment date override fields (see Figure 5) for the applicable payment. If the return is e-filed on or before the due date, the requested payment date cannot be later than the due date. If the return is transmitted after the due date, the requested payment date cannot be later than the date the return is transmitted.

Required Information

A Withdrawal selection (item #1 in Figure 5) is required if the program is to direct tax authorities to withdraw funds from the corporation’s bank account.

Figure 5: Required fields on PMT screen: withdrawal selection (1); account information (2); specified return (3)

The name of the financial institution, RTN, account number, and account type are required. As with the DD screen, the RTN, Account number, and Type of account data must be entered twice (item #2 in Figure 5).

Finally, the PMT screen must indicate the return to which the payment data applies (item #3 in Figure 5). Mark the box of the applicable return type: 1120, 7004, or 1120X.

Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal or state taxes. To have state amounts withdrawn from an account other than the account
indicated for federal payments, complete the fields in the State Account sections of the PMT screen.

NOTE Neither the federal nor the state balance due can be paid from more than one account.

### Filing an Extension

Calendar year returns are due on April 17, 2018. By filing Form 7004, a corporation can extend the deadline six months to October 15. Fiscal year returns are due on the 15th day of the fourth month after the end of the corporation's business year for corporations with other than a June 30 ending date; corporations with an ending date of June 30 must file their returns by the 15th day of the third month after the end of their business year.

The 7004 extends the deadline six months (seven months for corporations with June 30 ending dates).

Use one of the following options to file an extension for an 1120, 1120-C, or 1120-H:

- Go to the 7004 screen in Drake Tax and select Generate an extension. Complete any other applicable fields on the screen.
- Go to the PRNT screen and select Prepare Form 7004 extension based on screen 1 info.

### Signing the Return

Electronic PIN signatures are required for e-filed returns. To e-file a return, complete all fields on the PIN screen. A return cannot be e-filed if the PIN screen fields, including the title and signature (name) of the officer signing the return, are not complete.

An 1120 return must be signed and dated by one of the following individuals:

- The corporation’s president, vice president, treasurer, assistant treasurer, or chief accounting officer
- Any other corporation officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required information and “sign” the return (enter his or her PIN) in the space provided on the PIN screen. If it is prepared by an employee or officer of the corporation, go to screen 1 and select NONE in the Firm # and Preparer # drop lists.

To have the preparer’s name and address information displayed on the printed return:

- If the return preparer and ERO (entered in Setup > ERO & Account Information) are the same:
  - Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signature box is marked for the preparer.
  - Complete the PIN screen for the return.
• If the return preparer and ERO are not the same:
  – Go to the PRNT screen for the return and complete the field labeled PIN for preparer’s alternative electronic signature. The PIN entered should match the one entered for the preparer in Setup > Preparer(s). (For more information, press F1 in this field.)

**NOTE**
**Setup > ERO & Account Information** must still be completed in Drake Tax to e-file. For information on how to complete this setup window, see 2017 Drake Tax User’s Manual. See the IRS instructions for further details on signature requirements.

**TIP**
If you mark the “Signs return” check box on screen E, that officer’s information flows to the signature line of the return so you won’t have to reenter it on the PIN screen. You will still have to enter an officer’s PIN and signature date on the PIN screen for e-file.

**Amending a Return**

The program can automatically fill the 1120X screen for Form 1120X, Amended U.S. Corporation Income Tax Return.

When you amend a return in Drake Tax, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6, “Return Results,” of the 2017 Drake Tax User’s Manual.

**CAUTION**
When you amend a return in Drake Tax, the amended information replaces the original in the data file. Before amending a return, you should archive the original to avoid losing previously submitted data. For more information on archiving returns, see “Archive Manager” in Chapter 6, “Return Results,” of the 2017 Drake Tax User’s Manual.

**Returns Previously Prepared in Drake Tax**

From the Data Entry Menu of an 1120 return, enter X in the selector field and press ENTER. (Screen X is also accessible from the first Other Forms tab.) At the prompt, select Yes to automatically fill the screen with data from the original return (that is, the return as originally entered in Drake Tax). If the corporation’s name or address information has changed, enter the new information on screen X. Make all other necessary changes to the regular data entry screens.

Open screen X2 (or press PAGE DOWN while in screen X). Enter the line number from the X screen that corresponds with the changes that were made in data entry. (For instance, if you made a change in the tax on screen J, enter 4 (for “Tax”) in the Line Number field of the X2 screen.) Enter an explanation in the Explanation of changes text box.

If more than one item was changed in data entry, press PAGE DOWN to open another screen X2. Enter the line number from screen X that corresponds to this change and enter another explanation.

When you go to View/Print mode, the program calculates the amended return.

**New Returns**

To amend a return not previously prepared in Drake Tax, create an 1120 return in Drake Tax and open screen X. Complete the applicable fields on this screen, and then enter the amended data in the appropriate other screens, as described in the following example.
Example: An 1120 return was filed using a different tax program, but gross rental income was not reported on line 6 of the return. To amend the return:

1. Create an 1120 return in Drake Tax.
2. From the Data Entry Menu of the return, open screen X.
3. Complete all applicable fields on screen X.
4. Close screen X and open the INC screen.
5. Enter the amount of unreported income on line 6.
6. Close the INC screen and open screen X2.
7. Enter the line number from the X screen that corresponds to the changes that were made in data entry. (In this instance, if you made a change to income on the INC screen, enter 1 (for “Total Income”) in the Line Number field of the X2 screen.
8. Enter an explanation in the Explanation of changes text box.
9. Calculate and view the return. Note the adjustments made on Form 1120X.

To add Form 1120X to the queue for e-file, go to the EF screen for the return (accessible from the General tab of the Data Entry Menu) and mark the 1120-X box. For detailed instructions on e-filing the returns in the queue, see Chapter 8, “e-File,” in the 2017 Drake Tax User’s Manual.

Schedule K

Use screen K to enter data for Schedule K, Other Information. Screen K should also be used for Schedule K of Form 1120-C. Detailed here are some specific areas that might need your attention.

Schedule K, Line 3

On line 3 (line 5 of the 1120C column) of screen K, type the EIN and name of the parent corporation if the corporation is a subsidiary in an affiliated group or a parent-subsidiary controlled group.

Be aware of the following guidelines from the IRS:

- If the corporation is an “excluded member” of a controlled group (see definition in the Instructions for Schedule O (Form 1120)), it is still considered a member of a controlled group for this purpose.
- An affiliated group is one or more chains of includable corporations (section 1504(a)) connected through stock ownership with a common parent corporation. The common parent must be an includable corporation and the following requirements must be met:
  - The common parent must directly own stock that represents at least 80% of the total voting power and at least 80% of the total value of the stock of at least one of the other includable corporations.
  - Stock that represents at least 80% of the total voting power and at least 80% of the total value of the stock of each of the other corporations (except for the
common parent) must be owned directly by one or more of the other includable corporations.

- For this purpose, the term “stock” generally does not include any stock that (a) is nonvoting, (b) is nonconvertible, (c) is limited and preferred as to dividends and does not participate significantly in corporate growth, and (d) has redemption and liquidation rights that do not exceed the issue price of the stock (except for a reasonable redemption or liquidation premium). See section 1504(a)(4).

**Schedule K, Line 4**

If a corporation owned, directly or indirectly, 20 percent or more, or owned, directly or indirectly, 50 percent or more of the total voting power of all classes of the corporation’s stock entitled to vote, the applicable data appears on Schedule G. In Drake Tax, Schedule G data is entered on screens G1 and G2, accessible through the G1 Screen and G2 Screen links on line 4 of screen K, or from the General tab of the Data Entry Menu.

If the stock is owned by any foreign or domestic corporation, partnership, or trust, enter on screen G1 the name and EIN of the entity, the type of entity (foreign or domestic corporation, partnership, trust, etc.), the country of the corporation organization, and the percentage of stock the entity owns.

If the stock is owned by an individual or estate, enter on screen G2 the name and ID number of the individual or estate, country of citizenship, and percentage of stock owned.

Use the CTRL+PAGE DOWN function to open additional (blank) G1 or G2 screens. For more information on line 4 of Schedule K, see the IRS instructions.

**Schedule K, Line 5**

If the corporation owned stock in other corporations or partnerships or the beneficial interest in a trust, enter the information on the K5A or K5B screen. Click the K5A Screen or K5B Screen links on the K screen or from the General tab of the Data Entry Menu to access fields for entering this information.

Use the CTRL+PAGE DOWN function to open additional (blank) K5A or K5B screens. For more information on line 5 of Schedule K, see the IRS instructions.

**Schedule K, Line 7**

Complete the fields on line 7 of screen K if a foreign person owned, directly or indirectly, at least 25% of the total voting power of all classes of the corporation’s stock entitled to vote, or the total value of all classes of stock of the corporation. (If there is more than one 25%-or-more foreign owner, complete the fields for the person with the
highest percentage of ownership.) Enter the percentage that person owned and the owner’s country of residence.

NOTE

Generally, a 25% foreign-owned corporation with a reportable transaction during the tax year must file Form 5472, Information Return of a 25% Foreign Owned U.S. Corporation or a Foreign Corporation Engaged in a U.S. Trade or Business (screen 5472 in Drake Tax). See Form 5472 for filing instructions and penalties for failure to file.

See section 6038A(c)(5) and the related regulations for the constructive ownership rules of section 318 that apply in determining if a corporation is foreign owned.

NOTE

If another entity owns 20% or more of the client’s corporation, or owns 50% or more of the corporation’s stock entitled to vote, see “Schedule K, Line 4” on page 29.

Schedule K, Line 13

On line 13 of screen K, select Yes if the corporation’s total receipts (line 1a + lines 4 through 10 on page 1 of Form 1120) are less than $250,000 for the tax year, and its total assets at the end of the tax year are less than $250,000.

If the answer to line 13 is Yes, in the lower text box of line 13 enter the total amount of cash distributions and the book value of property distributions (other than cash) made during the tax year. (An entry here is added to the amount calculated from entries on line 5, “Distributions,” on the M2 screen and reflected on page 4, line 13, of the 1120 return.)

NOTE

If the answer on line 13 is Yes, the corporation is not required to complete Schedules L, M-1, or M-2. To force the program to print these forms, go to the PRNT screen and select Force Schedules G (1120-C), L, M-1, and M-2 to be printed.

Schedule K-1

The 1120 package includes a K1P screen (accessible from the first Other Forms tab of the Data Entry Menu) for entering information from Form 1065, Schedule K-1. This screen works the same as it does for the other packages, with amounts being carried automatically to the appropriate forms, schedules, and lines.

TIP

See “K-1 Export” on page 31 details on exporting K-1 data directly from a partnership return into the corporation’s K1P screen of Drake Tax.

In addition:

• Ordinary income flows to Form 1120, page 1, line 10, “Other income,” with the partnership name and EIN (required information).
• Ordinary losses flow to Form 1120, page 1, line 26, “Other deductions,” with the partnership name and EIN (required information).
Depending on your setup, the partnership name and EIN will appear in a statement referenced on line 10 or line 26.

Codes or lines that don’t flow to any other place may require additional information not available to the program and must be manually entered in the proper place in the return.

**Missing ID Number**

If the corporation received a Schedule K-1 from a partnership and the partnership did not have an ID number—for instance, if the partnership was foreign and did not have an EIN—type “F” into the Partnership EIN field of the K1P screen and the word FOREIGNUS is automatically entered. If the partnership had applied for an SSN or EIN but had not yet received an ID number, type “A” to have APPLD FOR entered in the Partnership EIN field.

**K-1 Export**

Take the following steps to export K-1 information from a partnership return into the K1P screen of an 1120 return. (The K1P screen in the 1120 does not have to be created beforehand.):

1. Open the partnership (1065) return in Drake Tax and go to View/Print mode.
2. Click K1 Export in the View toolbar. If any K-1s are not eligible to be exported, that list appears. Click Next to continue; otherwise, the Export K1s window is opened, containing a list of K-1s eligible for export.
3. All SSNs and EINs in the list are eligible for export. Remove the check mark from the box to the left of any EINs or SSNs you do not want to export (Figure 6).
4. Click Export. The K-1 data is displayed in the 1120 return in the program.

![Figure 6: Exporting K-1 data from a partnership return into the corporation return for Seay’s Trucking](image-url)
Oil and Gas Depletion Worksheet

The Oil and Gas Depletion Worksheet calculates oil and gas depletion and gives your clients the best possible deduction.

The DEPL screen is completed in the Business packages in a similar fashion to the 1040 package. For details, see “Oil and Gas Depletion Worksheet” on page 20 of this supplement and in Chapter 5 of the 2017 Drake Tax User’s Manual.

State-Specific Information

The program automatically generates a return for the corporation’s resident state. Use screen 2 to enter company information as it should appear on the state return.

NOTES

The link to screen 2 is on the States tab, (or enter 2 in the selector field and press ENTER.)

The company information fields on screen 2 apply for the resident state only.

Company information includes the type of return that applies for state purposes (consolidated, composite, controlled group), and state-specific dates and numbers for identification.

Contact Information

If certain contact information required for state purposes is different from that entered on screen 1, use screen 2. This screen has fields for the following types of contact information:

- Name and address of registered agent
- Principal place of business
- “Books in care of”
- General contact information for the name, title, email address, ID number, and telephone number of the corporation’s contact person.

Other States

Data for states other than the resident state must be entered manually in state data entry. To access state data entry, select the States tab from the Data Entry Menu, or enter the two-letter state code in the selector field and press ENTER.

Enter sales, payroll, and property factors on the APPT Multi-State Apportionment screen. This screen (Figure 7 on page 33) provides one central location for entering all state apportionment information instead of having to open each needed state’s screen.

In addition to making data input faster and easier, this feature provides two worksheets: a summary worksheet, “Wks SA-SUM,” that can be used for verifying input, and a reconciliation worksheet, “Wks SA-REC,” that ties the total of the state amounts to the federal return figures. These worksheets are available in View/Print mode.
The individual state apportionment screens can be used to override data entered on the APPT screen.

![Figure 7: State APPT screen](image)

**NOTE**

Mark the **Zero Apportionment** check box (Figure 7) to add a state but not include any apportionment data. This will include the state on the apportionment summary worksheet “Wks SA-SUM,” available through View/Print mode.

**APPT Screens**

The APPT screen is opened to the **Sales** tab. Links at the top of this screen open the **Payroll**, **Property**, and **Additional Property** information tabs for each state selected. These screens and their uses are listed in Table 1:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>Select state; enter sales, returns and allowance, and other income-related information for each selected state</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter salary, wage, commission, and labor amounts for each selected state</td>
</tr>
<tr>
<td>Property</td>
<td>Enter beginning and ending amounts of common apportionment factors, plus select additional apportionment factors from drop lists</td>
</tr>
<tr>
<td>Additional Property</td>
<td>Select additional apportionment factors from drop lists</td>
</tr>
</tbody>
</table>

**NOTE**

The **Ending** amount entered on the **Property** and **Additional Property** screens in Drake17 will become the **Beginning** amount for property on the APPT screen when the client's return is updated next year in Drake18.

You may enter up to four states on one APPT screen. If you need more than four states, press **PAGE DOWN** for a new APPT screen. The same state can be entered more than once when additional fields are needed.
Select **OT Other Reconciliation** from the **State Selection** drop list when using the reconciliation worksheet. Not every item appearing on the federal return may be subject to multi-state apportionment. When you select **OT**, the data entered becomes a reconciling adjustment amount to aid in tying to the federal return.

Enter as much or as little detail as the states require. If a state does not require any information to be entered, no information will flow to that state’s return.

**Updating APPT Screens**

Not all data entered on screen **ATTP** is updated each year. When you update (from the **Home** window, **Last Year Data > Update Clients**), the states selected on the previous year’s program are carried to the current year, and the “Ending” amounts on the two **Property** tabs of the **ATTP** screen from the previous year’s program become the “Beginning” amounts in the current year’s program.

**Other Information and Overrides**

Use screen **1** to enter the following additional information:

- **Resident State** — If the corporation has a mailing address in one state but does business in another, select the state in which the corporation does business from the **Resident State** drop list.

- **Miscellaneous Codes and Overrides** — Screen **1** includes fields for miscellaneous codes, invoice numbers, and several overrides. See “Listing a Different Firm, Preparer, or ERO on a Return” in Chapter 2 and “Miscellaneous Codes” in Chapter 5 of **2017 Drake Tax User’s Manual** for more information.

**Schedule L (Balance Sheet per Books)**

Schedule L is required if the corporation’s total receipts for the tax year or its total assets at the end of the year are greater than $250,000.

**Flow of Information**

Many of the entries made elsewhere (such as inventory information from Schedule A) flow automatically to the generated Schedule L. Depreciable asset information from the **4562** screen and intangible assets and amortization also flow to Schedule L.

Use the corporation’s balance sheet to enter data directly onto Schedule L.

**NOTE**

See “Importing Trial Balance Information” on page 53 for information on using the trial balance import to enter Schedule L data.

**Reconciliation Totals Displayed**

Schedule L and Schedule M-2 reconciliation totals are displayed on screens **L, L2**, and **M2** to facilitate reconciliation of the balance sheet (item #1 in Figure 8 on page 35).
Figure 8: Beginning- and End-of-Year totals displayed on screens L and L2 (#1); force printing end-of-year totals (#2)

Note that the totals from the balance sheet’s subsidiary schedule (SCH2 screen) also appear in the BOY Totals and EOY Totals columns of the L and L2 screens.

If you make any changes to the data, recalculate the return (press CTRL+C) for those changes to be displayed on the screen.

**NOTE**

The end-of-year totals also appear on screen M2 (Retained Earnings). From either screen L, L2, or M2, press PAGE UP and PAGE DOWN to toggle among screens L, L2, and M2 to make reconciliation easier.

**Force-Printing Final End-of-Year Totals**

Normally, if you mark Final on screen I, indicating that this is a final-year return, Drake Tax “zeros out” the EOY Totals column of Schedule L. Mark the Force-print final end of year check box on screen L (see item #2 in Figure 8) to display those totals in the EOY Totals column.

**The SCH2 Screen**

The SCH2 screen (see Figure 9 on page 36) is used to provide detailed information required by the IRS for certain lines on Schedule L. The amounts are carried to Form 1120 and printed on an attached statement.
This screen can also be used in place of the actual L screen in Drake Tax. If you use this screen for all applicable lines on Schedule L, you do not need to make any entries on screen L.

**NOTE**
To access the SCH2 screen from screen L, click an SCH2 Screen link. Press Esc to return to screen L.

**Entering Information**
To create a statement for a line using the SCH2 screen, select the desired line from the Line Number drop list and enter descriptions and their corresponding amounts.

![Figure 9: SCH2 screen fields for line number, description, and amounts](image)

Once the information is entered, or if additional descriptions are required for the line, press PAGE DOWN to access a new screen.

**NOTE**
All line selections and screen descriptions are carried to the next year, and year-end amounts are carried to the beginning-of-year column, when the returns are updated.

**Statements**
The total amounts entered on the SCH2 screen are not displayed on the actual L screen in the program. They are, however, printed on the return where needed, with references to the corresponding statements.

If a line is required, a statement (labeled “STATEMENT” or “STM” in View/Print mode, depending on your Setup Options) is produced and is e-filed with the return.

**SCH2 and Trial Balance Import**
Typically, one or more SCH2 screens are needed for Schedule L items. Data for the SCH2 screens cannot be entered directly into the trial balance worksheet, although the amounts must be included in the trial balance worksheet for the worksheet to balance. When the return is produced, Schedule L reflects the amounts imported from the trial balance worksheets but does not include the totals of the SCH2 screens; this data must be entered on the SCH2 screens.

See “SCH2 Detail” on page 60 for detailed instructions using the trial balance worksheet for SCH2 items and amounts.
Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year amounts. The program adjusts the unappropriated retained earnings amount on Schedule L by the difference between the total assets and the total liabilities and capital before the adjustment. For example, if assets are $1,000 and liabilities and capital are $900, the program increases the unappropriated retained earnings by $100.)

The program makes the adjustments due to differences in the balance sheet. Incorrect data entry could cause these differences but they are usually the result of one of the following issues:

• An asset deleted from 4562 screen (Depreciation - Detail Items) instead of being indicated as sold
• Beginning inventory amounts adjusted on Schedule A or ending inventory amounts were entered incorrectly
• Amounts erroneously deleted from or changed on screen L

To reconcile the differences, it is best to compare the corporation’s beginning and ending balance sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn off autobalance.

NOTE  If you are using trial balance import, autobalance must be turned off prior to import. See “Preparing to Use Trial Balance Import” on page 53.

Schedules M-1 and M-3 (Reconciliation of Income per Books)

Page 1 of Schedule M-3 is required if the balance sheet’s total assets at the end of the year equal or exceed $10 million, and pages 1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million. If the corporation’s assets do not equal or exceed $10 million but you want to voluntarily file Schedule M-3, or if the corporation’s assets do not equal or exceed $50 million and you wish to file the complete M-3, go to screen M3 and make a selection from the Voluntarily file M-3 drop list. Choose to print just page 1 of Schedule M-3 or the complete M-3.

NOTE  If the corporation is filing Schedule M-3, Schedule M-1 is not generated. Any entries on the M1 screen (for Schedule M-1) should be deleted.

Schedule M-1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus those accounting items that are not income tax items. When required, the corporation must reconcile book income with the taxable income.
Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax differences are classified as “permanent” or “temporary,” and as “favorable” or “unfavorable.” Examples of both kind of differences are shown in Table 2.

**Table -2: Examples Book-to-Tax Differences for Schedule M-1**

<table>
<thead>
<tr>
<th>Difference</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Permanent  | Book or tax items that will never be reported for book or tax purposes | - Meals & entertainment limitations  
- Penalties  
- Tax-exempt interest |
| Temporary  | Items that will be reported for both tax and book purposes, but not during the same tax year | - Depreciation  
- Gains or losses on the sale of depreciated assets |
| Favorable  | Items that reduce taxable income                  | - Instances in which tax depreciation amount is greater than book depreciation amount |
| Unfavorable| Items that increase taxable income                | - Disallowed meals & entertainment     |

**Schedule M-3**

Schedule M-3 is completed using the following screens, all found on the **General** tab of the **Data Entry Menu**:

- **M3, M31, M32, and M33** — for **Parts I, II, and III** of the Schedule M-3
- **M3B** — for Schedule B Additional Information for M-3 filers
- **SCH3** — for subsidiary schedules for Schedule M-3 and Form 8916-A
- **M3S** — for supplemental statements
- **8916** — for reconciling of M-3 with taxable income for mixed groups
- **916A** — for supplemental attachments to the M-3

If the corporation is required to file (or voluntarily files) Schedule M-3, the corporation must file Form 1120 and all attachments and schedules, including Schedule M-3.

**NOTE**

Certain income and deduction amounts and adjustments flow from Form 1120 to Schedule M-3 and Form 8916A in the program, but all other M-3 data must be entered manually.

If Schedule M-3 is present in a return, no Schedule M-1 is generated.

**Parts I-III**

Part I of Schedule M-3 asks certain questions about the corporation’s financial statements and reconciles financial statement worldwide net income (loss) for the corporation (or consolidated financial statement group, if applicable) as reported on Schedule M-3, Part 1, line 4, to net income (loss) per the income statement of the corporation for U.S. taxable income purposes, as reported on Schedule M-3, Part 1, line 11.

Parts II and III reconcile financial statement net income (loss) for the U.S. corporation (or consolidated tax group, if applicable) as reported on Schedule M-3, Part II, line 30 (column d), to taxable income (loss) as reported on Form 1120, page 1, line 28.
Certain items that are readily available flow to the M-3, but do not balance the M-3 automatically. To ensure that the M-3 balances, additional data entry may be required on the M31, M32, and M33 screens.

**Schedule B**
Schedule B is required when a Schedule M-3 is present in a return. Use screen M3B for Form 1120 Schedule B, Additional Information for M-3 Filers.

**The SCH3 Screen**
The SCH3 screen is similar to the SCH2 screen and is used to provide detailed information for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3 and 8916A screens. For more information on using this type of screen, see “The SCH2 Screen” on page 35.

## Schedule M-2 (Unappropriated Retained Earnings)
Information from Schedule M-2, “Analysis of Unappropriated Retained Earnings” ties to the Schedule L, line 25, portion of the balance sheet. Increases, distributions, and other decreases to the retained earnings are entered on Schedule M-2. Unappropriated retained earnings refer to corporation income that has not been distributed to shareholders that is available for dividend distribution.

**M-2 Troubleshooting**
The beginning Unappropriated Retained Earnings flow from Schedule L (Balance Sheet), and the “Net Income (Loss) per books” flows from the completed Schedule M-1 or M-3 on Form 1120. These numbers, combined with amounts entered on the M2 screen, are used to calculate the ending Unappropriated Retained Earnings.

If the computed amount does not match the amount in the completed Schedule L (Balance Sheet), the system produces an EF Message that says the M-2 is out of balance. Solving this problem can be challenging, since it can have any of several causes:

- The beginning balance sheet entries are inaccurate
- The Beginning of Year unappropriated retained earnings amount (line 25 on screen L) entered on the SCH2 screen for line 24 (“Retained earning-Appropriated”) is incorrect
- Autobalance is not turned on (See “Autobalance” on page 37.)
- The ending balance sheet entries are inaccurate
- The net income per the tax return is inaccurate
- The reconciling items on Schedule M-1 or M-3 need to be adjusted
- The reconciling items on Schedule M-2 need to be adjusted

If the items are off by a couple of dollars or less, resolve the problem by entering a reconciling item on the M2 screen:

1. Double-click in a field on the M2 screen to open a detail (CTRL+W) worksheet.
2. Enter the word “Rounding” as the description and enter an amount.
3. Press Esc. The program returns to the M2 screen.
If the problem is not resolved, it may be necessary to do a detailed comparison between the corporation’s financial records and the completed return information.

**Schedule O (Controlled Group Information)**

Use screens **O** and **OM**, accessible from the first **Other Forms** tab, to fill out Schedule O, Consent Plan and Apportionment Schedule for a Controlled Group. Press PAGE UP and PAGE DOWN to navigate from screen to screen.

**NOTE**

Members of a controlled group are entitled to one $50,000, one $25,000, and one $9,925,000 taxable income bracket amount, in that order.

**AMT Adjustments and Other Items**

Alternative Minimum Tax (AMT) adjustments are limited among the members of a controlled group. These should be entered in the **Other** information fields of the **OM** screen (Figure 10).

![Figure 10: Other information fields for other AMT adjustments](image)

**Types of Controlled Groups**

At the top of screen **O**, mark the box indicating the type of controlled group for which Schedule O is reporting. Controlled group types are briefly defined below. See Schedule O instructions for more details.

- **Parent-subsidiary group** — One or more chains of corporations that are connected through stock ownership with a common parent corporation if certain conditions apply.
- **Brother-sister group** — Two or more corporations if the same five or fewer persons who are individuals, estates, or trusts directly or indirectly own stock of each corporation with a certain amount of voting power.
- **Combined group** — Three or more corporations, each of which is part of a parent-subsidiary group or a brother-sister group, and one of which is (1) a common parent corporation included in a group in a parent subsidiary group, or (2) included in a group of corporations in a brother-sister group.
- **Life insurance companies only** — Two or more insurance companies subject to tax under section 801, that are members of one of the previously described groups, are treated as a particular type of controlled group.
Line 5, Apportionment Plan Status

The corporation is required to provide information about the status of the group’s apportionment plan. Select the applicable box on line 5 of screen O to show the status of the controlled group’s apportionment plan. If adopting a plan or amending the current plan for a prior tax year, at least one year must remain on the statute of limitations for each group member for assessing any resulting deficiency.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. The required adjustments flow to the appropriate line of the return and to Schedule M-1 or M-3. Manually reducing the expenses/deductions or increasing the income for these credits causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following credits:

- Form 6478, Biofuel Producer Credit
- Form 8864, Biodiesel and Renewable Diesel Fuels Credit
- Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction/expenses for the credit amounts for the following credits:

- Form 5884, Work Opportunity Credit
- Form 6765, Credit for Increasing Research Activities
- Form 8820, Orphan Drug Credit
- Form 8844, Empowerment Zone and Renewal Community Employment Credit
- Form 8845, Indian Employment Credit
- Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Certain Employee Tips
- Form 8881, Credit for Small Employer Pension Plan Startup Costs
- Form 8932, Credit for Employer Differential Wage Payments
- Form 8941, Credit for Small Employer Health Insurance Premiums

Adjusting Charitable Contributions/NOL

Corporations with a net operating loss (NOL) carryover from any taxable year must apply the special rule of IRC section 170(d)(2)(B) for charitable contributions. The rules are designed to prevent a double tax benefit through interaction of NOL and charitable contribution carryovers. The excess charitable deduction can reduce taxable income only once. Under these rules, a corporation’s charitable contributions carryover (but not the NOL carryover) must be reduced to the extent the charitable contribution deduction, in computing the taxable income of an intervening year, would increase the NOL to a succeeding year.
Limitation on Deduction

The total amount claimed cannot be more than 10% of taxable income (line 30) computed without regard to the following:

- Any deduction for contributions
- The special deductions on line 29b
- The deduction allowed under section 249
- The domestic production activities deduction under section 199
- Any net operating loss (NOL) carryback to the tax year under section 172
- Any capital loss carryback to the tax year under section 1212(a)(1)

To prevent the double benefit from the excess charitable contribution deduction when there is a charitable contribution on the return and an NOL carryover, the program makes the IRC section 170(d)(2)(B) adjustment. In this situation, the charitable contribution carryover amount is reduced on column C of the Contribution Limitation/Carryover worksheet (WK_CNTRB in View mode), and the NOL carryforward is increased on the ATT_NOL worksheet.

Elections

The ability to make certain tax elections is included in the business packages. Elections are selected from the Return Elections section of the ELEC screen (Figure 11).

Making an Election in Drake Tax

To indicate that the corporation is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry Menu (or by typing ELEC in the selector field and pressing ENTER).
2. Make a selection from the Election drop list (Figure 12 on page 43).
3. Complete all other fields as applicable. Press F1 in any field to learn if a field is required for your selection and the type of information that may be needed. For example, the help text for the Date or year-ending field (Figure 13) shows that the field is required only for election options 08, 09, 11, and 15, and it explains what, specifically, should be entered for each of these elections.

**Figure 13: Help text for Date or year-ending field on ELEC screen**

If the election option you selected is not listed in the help text for a field, then that field should be left blank. For example, if you chose election “01 - General Election Statement,” you would not need to enter anything into the Date or year-ending field.

To open a new ELEC screen for an additional election, press PAGE DOWN.

**Election Statements**

Once an election is made and the return is calculated, the election information is produced on a statement referenced “Statement ELXX,” where “XX” is the number of the election. For example, election “01 - General Election Statement” is generated as Statement EL01.

**NOTE**

If, at Setup > Options > Calculation & View/Print tab, you selected not to Print only one overflow statement per page, election statements are not numbered but each is listed within a “Statement.”
The election statement includes the election title, election wording, and any additional information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other times, they are included as separate lines. Signature lines are printed as needed on some statements.

**Safe Harbor Elections**

The **Building qualifies for Section 1.263...** check box on screen 4562 allows you to apply a small taxpayer Safe Harbor election to the building listed in the **Description** field. An election statement (“**ELEC**”) is produced and the building description as entered in the **Description** field is included in the election statement.

This election can also be made from the **Election** drop list on the **ELEC** screen.

This Safe Harbor election covers buildings only.


Another safe harbor election available from the **Elections** drop list on the **ELEC** screen is the Sec. 1.263(a) - 1(f) de minimis safe harbor election.

Election statements are generated with the return (Figure 14).

**NOTE**


Another safe harbor election available from the **Elections** drop list on the **ELEC** screen is the Sec. 1.263(a) - 1(f) de minimis safe harbor election.

Election statements are generated with the return (Figure 14).

**Making Changes on the Fly**

Use the **PRNT** screen to override most program defaults.

**Suppressing/Forcing Documents**

To suppress or force the printing of certain documents, go to the **PRNT** screen and select the desired options. Many “on-the-fly” changes override the options established in Setup.

You can force the program to print the following 1120 items on a return:
• Form 1125-E
• Schedules G (1120-C), L, M-1, and M-2
• Form 4562
• Next-year depreciation listing
• Inactive returns
• PIN for the preparer’s alternative electronic signature

Form 1125-E is required if total receipts (line 1b + lines 4 through 10) are $500,000 or more. Schedules L, M-1, and M-2 are not required if receipts and total assets (Schedule K, line 13) are less than $250,000.

The PRNT screen can also be used to suppress printing of the following items on a return:
• Form and attachment references (References are printed by default.)
• Form 4626, Alternative Minimum Tax—Corporations
• Proformas preparing for next year’s tax season

Calculation and Other Options

The following calculation and other options are available on the PRNT screen:

• **Calculate Form 2220 penalty** — Select this box to have the program calculate the penalty for Form 2220, Underpayment of Estimated Tax by Corporations. (The program retains the rates as of 12/31 of the calendar year. If a corporation has a fiscal year end, the preparer must enter the effective rates manually.)

• **Do not calculate WK_1120W based on 2017 taxable income** — Worksheet Wks 1120W is an estimated tax worksheet based on the current tax year taxable income. Select this box to stop generation of this worksheet.

• **Calculate Form 4466 (application for quick refund)** — Form 4466, Corporation Application for Quick Refund of Overpayment of Estimated Tax. (A check mark in this box is the only entry needed to generate the form.)

• **Turn off autobalance** — For more information on the autobalance feature in Drake, see “Autobalance” on page 37.

• **Prepare Form 7004 extension based on screen 1 info** — Select this box to prepare a six-month extension based on the information that has already been entered into the return. Note that screen 1 must be completed to prepare an extension.

To prepare Form 7004 based on information other than (or in addition to) that provided on screen 1, use the 7004 screen.

Overriding Other Setup Options

The following program defaults can be overridden from the PRNT screen:

• Filing instructions (federal and state)
• Envelope cover sheets (corporation, IRS, state, and city)
• Date to print on return
• Due date to print on letter and filing instructions (see Note, following)
• Amount on Form 1120, page 1, item D (“Total assets”)
• IRS Service Center

NOTE
A default due date for filing is printed on all letters and filing instructions generated with a return. You can override the default by entering an alternate due date in the Due date to print on letter and filing instructions field on the PRNT screen.

Electronic Filing

Steps to e-file Form 1120 are the same as to e-file Form 1040, with the exception of bankruptcy returns, which must be paper-filed.

Common Reject Codes

If one or more of the following IRS reject codes are generated when you e-file an 1120 return, you must contact the IRS for further information. The IRS e-Help Desk telephone number is (866) 255-0654.

• Reject Code F1120-307-01 — Filer’s TIN and “Name Control” in the return header must match data in the e-file database unless Form 1120, Item E (3), check box “Name Change” is marked.
• Reject Code R0000-900-01 — The return type indicated in the return header must match the return type established with the IRS for the EIN.
• Reject Code R0000-905-01 — Electronic Filing Identification Number (EFIN) in the return header must be listed in the e-file database and in “accepted” status. If you get this reject code, you must update your e-file application to include the 1120 return type. This should be done at the IRS website. Review publication 3112 for details.
• Reject Code R0000-932-01 — If “Amended Return” or (Superseded for 1120/1120S) check box is not selected, then Taxpayer TIN in the return header must not be the same as a TIN of a previously accepted paper return for the return type and tax period indicated in the tax return.
• Reject Code R0000-933-01 — If “Amended Return” or (Superseded for 1120/1120S) check box is not selected, then Taxpayer TIN in the return header must not be the same as a TIN of a previously accepted electronic return for the return type and tax period indicated in the tax return.

Special Types of Returns

This section covers 52-53–week year returns and inactive returns. Both types of returns can be e-filed using Drake Tax.
ELECTING A 52-53-WEEK YEAR (INITIAL RETURN)

To elect a 52-53-week year, a new entity (one that has never filed a return) must enter data on both screen 1 and the Year screen.

To elect a 52-53-week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year begins and Fiscal year ends dates. Use the MMDDYYYY format, as shown in the example in Figure 15.
2. Mark the 52-53-week tax year box.

![Figure 15](image)

In this example, the fiscal year begins 04/28/2017 and ends 04/27/2018 (the Friday closest to the end of April), giving the entity a 53-week year for 2018.

NOTE

An entity that has filed returns in the past must complete only steps 1 and 2 of this process. An entity that has never filed a return before must continue with steps 3 through 6.

3. Click the Year link to open the Short-Year Election screen (Figure 16).

![Figure 16](image)

Figure 16: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53-week year ends for the current fiscal year. (01 = January, 02 = February, etc.)
5. For line 2, select the day of the week the tax year always ends.
6. For line 3, enter the actual date that the tax year ends (the same date entered in the Fiscal year ending field on screen 1).

NOTE

Once a 52-53-week year is selected, the entity must use that accounting period every year. To change accounting periods, the entity must submit to the IRS Form 3115, Application for Change in Accounting Method.

In subsequent years, only the 52-53-week tax year check box on screen 1 must be marked; the program automatically updates the dates.
Inactive Returns

Entities that are inactive but still required to file returns may e-file inactive returns in Drake Tax. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.
2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on the main form of the return (specifically, in the box above line 1c). Zeros (“0”) are displayed where required by the IRS in order for amounts to be properly included in the e-file data.

**IMPORTANT** All EF Messages must be cleared in order to e-file an inactive return.

For detailed instructions on e-filing returns in Drake Tax, see 2017 Drake Tax User’s Manual.

Foreign Tab


Also available on the Foreign tab are the screens used in completing Form 8938, Statement of Specified Foreign Financial Assets, Form 5472, 25% Foreign-Owned U.S. Corporation, and Form 5471, Information Return of U.S. Persons with Respect to Certain Foreign Corporations.

For more on completing FinCEN Form 114, see “Foreign Financial Accounts” in Chapter 5 of the 2017 Drake Tax User’s Manual.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are generally signature or third-party documents such as a copy of a signed lease or a signed appraisal statement. In some instances, the IRS requires that a document be attached to an e-filed return; in other instances, a document can be attached voluntarily to support or explain an entry in the return. In either case, a PDF must be available to be attached to the return in order to be e-filed with the return.

Attach files through the PDF Attachments screen, accessible from the Electronic Filing section on the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake Tax:
1. Creating a PDF file to be attached
2. Informing the program that a PDF file will be sent with the return
3. Attaching the PDF file for e-file

These steps are described in the following sections.

**Creating a PDF File**

To create a PDF file:

1. Scan the document to be attached to the return as a PDF document.

**Tip** It’s a good idea to use the Drake Documents scanning feature for this step.

2. Save the document to your client’s Drake Documents file, your computer’s desktop, or anywhere you can readily find it.

**Note** Many types of documents (for instance, documents created in Microsoft Word) can be printed or “saved” as PDF files if you have a PDF printer (such as Adobe Reader) installed.

**Adding PDF Files**

To indicate in the software that a PDF file will be sent with the return:

1. Open the return in Drake Tax.
2. From the Data Entry Menu, click PDF Attachments, accessible from the Electronic Filing section of the General tab (or type PDF in the selector field and press ENTER).
3. Fill out the columns on the screen. See Table 3 for examples.

**Table -3: PDF Attachment Window Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| **Reference Source** | Name or number of regulation, publication, or form instruction that makes attachments necessary | - IRS Pub xxx-1.4  
                      |                                                                                   | - Form Instructions for 1120 |
| **Description**   | Description of form or document to be attached                              | - Title of house on Oak Street       |
|                   |                                                                             | - Appraisal of Lot 1234               |
| **File name**     | Distinctive, easily recognizable file name, followed by “.pdf”              | - TitleHouseOakSt.pdf                 |
|                   |                                                                             | - AppraisalLot1234.pdf               |

4. Exit the PDF screen.

Because you’ve indicated that a PDF file is attached, the program generates an EF Message regarding the attachment when the return is calculated.

**Attaching Documents to the Return**

To attach a PDF file to a return:
1. From the return, click View. If anything was entered on the PDF screen, there will be three PDF–related items in the View/Print window:
   • A red MESSAGES alert (see item #1 in Figure 17)
   • An “EF PDF” worksheet that lists all items entered on the PDF screen (item #1 in Figure 17)
   • An Attach PDF button on the toolbar (item #2 in Figure 17)

2. Click the MESSAGES file to view the EF Message which provides information on how to attach the required documents to the return.

3. Click the Attach PDF button in the toolbar at the top of the window. The EF PDF Attachments window (Figure 18) displays the information entered on the PDF Attachments window in data entry. A red circle with an X means the document has not yet been attached; a green circle with a check mark indicates an attached document.

4. Click the row of a document with a red circled X you wish to attach it to the return.

5. Click Browse.

6. Find the proper folder, select the PDF file to attach, and click Open (or double-click the file name). The X is replaced with a check mark.
Repeat for all documents with an X. When all documents have been attached to a completed return, recalculate the return to make sure all EF messages have been cleared. If so, the return is ready to be e-filed.

**Form 3115, Application for Change in Accounting Method**

Form 3115, Application for Change in Accounting Method, is an application to the IRS to change either an entity’s overall accounting method or the accounting treatment of any material item.

Form 3115, Application for Change in Accounting Method, is eligible for e-file, but an additional copy of the form must be mailed to the IRS national office unless the Appendix of Rev. Proc. 2011-14 of other published guidance requires the copy to be filed with the IRS office in Ogden, UT. (See IRS instructions for details.)

Drake Tax customers can fill out and e-file Forms 3115 and related schedules and attachments for corporation returns.

**Accessing Screens for Changing Accounting Method**

Several screens may be required to complete Form 3115. These screens are accessible from the **Change in Accounting Method** box, located under the second **Other Forms** tab of the **Data Entry Menu** (Figure 19).

![Figure 19: Screens for Form 3115, Application for Change in Accounting Method](image)

The screens accessible from the **Change in Accounting Method** section include:

- **Screen 3115 (Change in Accounting Method)** — Used to access fields for Form 3115, including Schedules A through D
- **Screen 311E (Schedule E)** — Used to request a change in depreciation or amortization methods
- **Screen ATT (Explanations and Attachments)** — Used to create and view certain attachments to be generated by the software
• Screen ATT2 (Pt II Ln 14 & Pt III Ln 24b Attachment) — Used to complete certain parts of Form 3115 that require specific attachments

**Multi-form Codes**

All 3115 and related screens contain a Multi-form code text box (shown in Figure 20) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new application you create in Drake Tax. The first should be “1,” the second “2,” and so on. When using other screens, such as the 311E or ATT screens, you can use those multi-form code numbers to indicate with which instance of Form 3115 the 311E or ATT screen should be associated.

**NOTE** If only one Form 3115 is being submitted, you do not need to enter anything in the Multi-form code box.

**Form 3115 Screens**

When you open the 3115 screen from the Data Entry Menu, the program displays the first of five 3115 screens. These five screens are:

- Part I (Form 3115, Part I)
- Part II (Form 3115, Part II)
- Parts III, IV (Form 3115, Parts III and IV)
- A, B, C (Form 3115, Schedules A, B, and C)
- D - Parts I, II (Form 3115, Schedule D, Parts I and II)
- D - Part III (Form 3115, Schedule D, Part III)

As shown in Figure 20, you can access these 3115 screens by clicking a link at the top of any of the 3115 screens.

![Figure 20: Tab links on 3115 screen](image)

For details on how to file Form 3115, see IRS Revenue Procedure 2015-13.

**NOTE** Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for general automatic change procedures, and to Rev Proc. 2015-14 for a list of automatic changes to which the automatic change procedures in Rev. Proc. 2015-13 apply.
In addition to Form 3115 and related schedules and statements, the program produces EF Messages (as applicable) when the return is calculated. All forms, schedules, EF Messages, and worksheets are accessible in View/Print mode.

EF Messages for Form 3115 provide information about required attachments (including PDF attachments) that are missing from the return. Some messages list all statements required for a particular section but do not indicate which statements, specifically, are missing. To better understand which attachments are still required, compare the ATT screen and the “EF PDF” worksheet to the list on the EF Message.

All EF Messages must be eliminated before the return is eligible for e-file. EF Messages for Form 3115 attachments are eliminated when all required statements have been attached to the return.

Drake Tax’s trial balance import feature allows data to be imported into an 1120 return from a trial balance worksheet. The trial balance template and importing function has the following benefits:

- Eliminates the need to duplicate entries
- Reduces data entry errors by automatically importing data to the correct fields
- Allows preparers to merge basic accounting functions with tax preparation

A flow chart of the trial balance importing process is available as Appendix A, Trial Balance Import (pages A-1 to A-2 of this manual).

The trial balance import function can be used only on returns that were created in Drake 2008 or later. Like several other functions of the tax program, this feature requires Microsoft Excel (version 2000 or later).

First, if you haven’t already, create a client file (open a new return) in Drake Tax 2017 or update an existing client file from the prior year. Then create a trial balance worksheet. (See “Opening a Template” on page 55.)

Then take the following steps to ensure the trial balance import works properly:

- **Activate Macros** — The trial balance import function uses macros in Microsoft Excel. Check your Excel settings to ensure that macros are activated and that macro settings are set to “Disable all macros with notification.” To do so, go to
File > Options in Excel and select the Trust Center tab. Click Macro Settings and select Disable all macros with notification, then click OK.

In Excel 2007, click the Office button in the upper left and then click the Excel Options button at the bottom of the window. (In Excel 2013, click the File tab then select Options from the menu on the left.) Next, select Trust Center from the list at left, then click the Trust Center Settings button. Select Macro Settings from the list on the left, then choose Disable all macros with notification. Click OK and then OK.

- **Disable Autobalance in Drake Tax** — (optional) When autobalance is disabled, the program is prevented from automatically adjusting the year-end retained earnings or capital amounts, thus allowing you to see any discrepancies in the balance sheet. To disable autobalance in Drake Tax, go to the PRNT screen and select Turn off autobalance.

- **Force Schedule L** — By default, the program does not display the balance sheet amounts on the return if the corporation does not meet the filing requirement. If this is the case, you have to override the default setting in order to have the amounts displayed on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT screen and select the applicable check box (Figure 21).

![Figure 21: Check box for forcing Schedule L](image)

- **Check for Detail Worksheets** — The trial balance import allows only those detail worksheets required by the IRS. Check updated returns for detail (CTRL+W) worksheets that are not required. For example, the IRS does not require a detail worksheet for the Gross receipts or sales field on the INC screen; if a return has a detail worksheet for that field, the trial balance will not be imported correctly into the return. Detail worksheets are indicated by red shading, as shown in Figure 22.

![Figure 22: Example of an “unnecessary” detail worksheet](image)
Remove (press CTRL+D) unnecessary detail worksheets prior to import. See “Detail Worksheets” on page 56 for more information on using detail worksheets in the trial balance.

### Preparing Financial Data for Import

To prepare the financial data for importation into the return, the data must be entered into Drake Tax’s specially designed trial balance template. Once this information is entered and saved, it can be imported into the return.

**Opening a Template**

The first step in preparing financial data for importing is to open a trial balance template for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the **Data Entry Menu**.
2. Click **Import > Trial Balance Import** from the toolbar. The preliminary **Trial Balance Import** dialog box is opened.
3. Click **Create New** or **Open Existing**. If opening an existing file, click **Open** after selecting the correct file.
4. If a **Security Warning** box appears, click **Enable Macros**.

**NOTE**

In Excel 2007 and 2010, you may see a **Security Warning** message with an **Options** button. Click **Options** to open the **Security Options** dialog box, then select **Enable this content**. Click **OK**. (In Excel 2013, click **Enable Content**.)

The trial balance template is displayed in Microsoft Excel.

**File Location**

Whenever a new template is opened, the tax program assigns it a default file location and name. Trial balance templates are saved in the “TB” folder of your Drake17 program.

To change the name of a file in Excel, select **File > Save As** and assign the new name.

**NOTE**

If saving a trial balance to a different location, make a note of where you are storing it. The program automatically looks in the default directory.

**Template Structure**

The trial balance template consists of three title rows and six columns. The **Entity Name** and **Year End** title rows can be edited; double-click a row to change the title. Columns are described in Table 4.

**Table -4: Trial Balance Template Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Title</td>
<td>Title of account</td>
</tr>
<tr>
<td>Debit/Credit</td>
<td>Debit and credit amounts</td>
</tr>
</tbody>
</table>
Displayed at the bottom of the trial balance worksheet are the calculated amount for Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the balance sheet is out of balance and, if applicable, the out-of-balance amount (Figure 23; see also Figure 26 on page 58).

Following are instructions and guidelines for using the trial balance template to assemble financial data for importing into data entry.

**Entering Financial Data**

When a new trial balance file is opened for a return, all debit and credit amounts are zero ($0). All data must be entered manually into the template.

**NOTE**

Some data cannot be imported from the trial balance worksheet into the tax program and must be entered directly into the data entry fields within the program. For more on these categories of data, see “Special Conditions” on page 59.

**Direct Entry**

Most cells in the trial balance worksheet are view-only. In a new template, editable debit and credit cells are indicated by a dollar amount ($0).

**Detail Worksheets**

Some cells require more detail than can be entered on a single line. These cells are indicated by buttons (Figure 24 on page 57). (Buttons do not work if macros are disabled; see “Opening a Template” on page 55.)
Click a worksheet button to open a worksheet in a new tab. Figure 25 shows an example of the “Other Income” worksheet.

To return to the previous worksheet, click the Corp TB tab (labeled “1” in Figure 25), or the Click to return to TB button above the worksheet tabs (labeled “2” in Figure 25). Note that a detail tab (the “Other Income Detail” button labeled “3” in Figure 25) might include one or more detail worksheets.

**NOTE**

Do not create detail worksheets in data entry of Drake Tax if the trial balance worksheet does not provide an equivalent detail worksheet; otherwise, the trial balance will not be imported correctly.

**Totals**

Totals are displayed at the bottom of each worksheet. If credit and debit columns are out of balance, the worksheet highlights the out-of-balance amount (Figure 26 on page 58).
In addition to credit and debit totals, the main trial balance worksheet displays the net income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjustments are made in the program.

**NOTE** The data cannot be imported if the worksheet is out of balance.

### Saving a File

To save a file, click the **Save** icon or select **File > Save** from the menu bar. (In Excel 2007 and 2010, click the **Office** button in the upper-left corner and select **Save**. In Excel 2013, click the **File** tab then **Save**.) To re-name a file when saving, select **File > Save As**. Trial balance templates are saved in the “TB” folder of your Drake17 program.

### Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake Tax, the trial balance information can be imported into the program and calculated into the return.

Not all trial balance data can be imported directly into a return. For information on program limitations, see “Special Conditions” on page 59.

If you are already in the Trial Balance Import tool for the selected return, go to the **Trial Balance Import** window in Drake Tax and start at Step 3 of the following procedure.

To import a trial balance into a return:

1. Open the return to which you will import the trial balance information.
2. Click **Import > Trial Balance Import** from the menu toolbar. The preliminary **Trial Balance Import** dialog box is opened. Click **Next**.
3. Enter or select the trial balance file to be imported. Use the **Browse** feature if necessary. By default, each trial balance file is an Excel (.xls) file displaying the cli-
4. Select the **Trial Balance Additional Import Options**. (See “Additional Import Options” following this procedure.)

5. Click **Next** and wait for the import to be completed.

6. Click **Finish**.

The program returns to the **Data Entry Menu** for the open return. Note that all selected data from the trial balance worksheet has been imported into the return. This can be seen both in the data entry screens and on the generated return.

### Additional Import Options

The program can import the following additional information when importing the trial balance data: Select the items to import or click **Select All** then click **Next**.

- Buildings & other depreciable assets
- Accumulated depreciation
- Goodwill & other intangible assets
- Land
- Accumulated amortization
- Cost of goods sold (COGS) depreciation

### Special Conditions

Some trial balance items cannot be entered into the trial balance worksheet and must be typed directly into Drake Tax data entry. Other items should be entered into the worksheet for balance purposes but are not carried to data entry; these must be entered separately and the calculated results compared to the trial balance worksheet.

### Details for Preparers

Most trial balance items are imported directly to the location indicated in the program and on the return. For example, the amounts shown in Figure 28 go to Schedule L, line 1, column d in the program and are shown on page 5, line 1, column d of the 1120 return.

![Figure 28](image)

**Figure 28:** Trial balance worksheet indicates where an amount will go in Drake Tax and on the return.
The “Other Information” column in the trial balance worksheet indicates special conditions and additional information regarding certain rows. Table 5 describes the most common notes in this column.

**Table -5: “Other Information” Column Notes**

<table>
<thead>
<tr>
<th>Note</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>not included in totals</td>
<td>The amount is required for importing purposes only but is not included in the totals shown on the trial balance.</td>
</tr>
<tr>
<td>does not import</td>
<td>Information cannot be imported and must be entered on the appropriate screen in Drake Tax. Screen is specified in “Form, Page, Sch...” column to the left of “Other Information.”</td>
</tr>
<tr>
<td>optional</td>
<td>Amount is optional; not required for import, but could require direct entry in the software.</td>
</tr>
<tr>
<td>(enter deficit as negative)</td>
<td>Some deficits must be entered as negative numbers.</td>
</tr>
<tr>
<td>import includes the calculated</td>
<td>Used for “total purchases;” when calculating cost of goods sold (COGS) in the return, the program takes the change in inventory into account for the Schedule A calculation.</td>
</tr>
<tr>
<td>change in inventory</td>
<td></td>
</tr>
<tr>
<td>[Form or Schedule] may be required</td>
<td>Non-financial information (such as names of officers for a Schedule E) must be completed in Drake, in addition to the financial data entered in the worksheet.</td>
</tr>
</tbody>
</table>

All “does not import” notes are accompanied by further instructions in the column to the left of the “Other Information” column, as shown in Figure 29 on page 61.

**SCH2 Detail**

Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is required for an item marked “does not import” on the trial balance worksheet (Figure 29 on page 61).
To complete an SCH2 detail screen in data entry of the tax program:

1. Open the SCH2 screen for the return.
2. Select the line number from the Line Number drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

**NOTE**

Alternately, open screen L and click the SCH2 Screen link for the line your wish to enter.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts imported from the trial balance worksheet and the totals of the amounts entered on the SCH2 screen.

**Depreciation**

On an 1120 return, total depreciation consists of COGS depreciation, which is reported on Form 1125-A, Cost of Goods Sold, and any remaining depreciation, which is reported on page 1 of the return. For trial balance purposes, enter depreciation amounts directly into the appropriate fields on the trial balance worksheet.

When the trial balance is imported, the COGS depreciation expense amount flows directly to the appropriate line of Form 1125-A on the return. Because the remaining depreciation can comprise any number of assets, the amount entered on the trial balance does not flow to the return. To ensure that each component of the total remaining
depreciation is calculated into the return, each asset must be entered on the applicable
depreciation screens in data entry.

Entering the remainder of the depreciation on the trial balance worksheet helps ensure that the balance sheet balances and provides a way to check that the amount on line 1 of Schedule M-1 is correct. Compare the calculated line 1 at the bottom of the trial balance to the equivalent line on Schedule M-1 of the calculated return. If the depreciation amounts match but the line 1 amounts differ, an M-1 adjustment could be required.

**NOTE**

**“EF Notice” Page**

Similar to federal Form 9325, Acknowledgment and General Information for Taxpayers who File Returns Electronically, generated with 1040 returns, the federal and state business packages now generate an “EF Notice” page for the main forms of federal returns and “(ST)EF_ACK” page for the main forms of state returns.

This is a Drake-generated form that serves the same purpose as Form 9325: an acknowledgment that a return has been transmitted through Drake Software and received by the IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being processed) or an “R” ack (for a rejected return), the top section of the EF Notice is completed, noting the name and address of the client, the return type, the ERO who transmitted the return, and a check mark indicating the return was received by the IRS or applicable state agency.

When you download and process your acknowledgments and receive an “A” ack, the second section of the EF Notice is generated, indicating the return was accepted by the IRS or state agency and the date the return was accepted. The submission ID number is also included.
Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporation tax return from a trial balance worksheet.

Drake Tax’s specially designed trial balance template and importing function has the following benefits:

• Eliminates the need to duplicate entries
• Eliminates data entry errors by automatically importing data to the correct fields
• Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
Trial Balance Import: General Process

Prepare to use Trial Balance Import
- Activate Excel macros
- Disable autobalance
- Force Schedule L
- Delete unnecessary detail worksheets

Trial Balance Template (Import > Trial Balance Import)
- Direct entry data (cells with $0)
- Applicable detail worksheets
- Totals for:
  - Depreciation
  - Schedule L
  - Rentals (1120S & 1065 only)

Data Entry
Enter any trial balance data that cannot be imported via Trial Balance Import
- Screen SCH2 for Schedule L items
- Screen 4562 for individual assets (depreciation)

Compare M-1, line 1: Does trial balance match Schedule M-1, line 1?
-YES 1120 return?
-NO Were rental totals entered in trial balance?
  -YES Go to data entry and enter individual rentals on 8825 or RENT screens as applicable
  -NO Delete imported 8825 and RENT screens

Did data import correctly?
-NO Make corrections in TB worksheet

Is an M-1 adjustment necessary?
-YES Adjust amounts elsewhere in data entry
-NO Make M-1 adjustment

Process complete!
Index

A
accounting method
   changing 51, 51–53
address
   e-mail 32
   entering on Form 1120 12
adjustments and credits 41
advertising expenses 20
affiliated groups 28
alternative minimum tax (AMT) 40
amended returns 27–28
amortization 21, 34
APPLD FOR 17, 31
apportionment
   plan status 41
attachments
   binary 48–51
   PDF, see PDF files
to Form 3115 51
auto-balance 37, 45

cost of goods sold, see Schedule A (Cost of Goods Sold)
coversheets 46
credit for tax on fuels 17
credits
   carrybacks and carryforwards 22
credits and adjustments 41
Ctrl+W (detail) worksheets 15, 54

D
data entry
   trial balance import 56
DBA 12
debts, bad 18
deductions and income 14–21
depreciation
   and auto-balance errors 37
   oil and gas 20, 32
   for cost of goods sold (Schedule A) 15
   on short-year returns 13
   trial balance (business returns only) 61
detail (Ctrl+W) worksheets 15, 54
detail) worksheet 15
direct debit of balance due 25–26
doing business as 12
Domestic Production Activities 21
domestic production activities deduction 21

calendar years 12
capital gains and losses 16
carryover of NOLs 21, 41
Change in Accounting Method 51–53
Changes on-the-fly 44
charitable contributions 19, 41
codes
   error/reject 46
   miscellaneous (screen 1) 34
   multi-form 32
   state 32
combined group 40
compensation of officers 17
consolidated returns 15
contact information (for state returns) 32
contributions, charitable 19, 41
controlled groups 22, 40
converting to 1120 11

electronic
   funds withdrawal (direct debit) 25
   signatures (PIN) 26
employee benefits 21
entertainment and meals 21
envelope coversheets 46
estimated tax worksheet 45
estimates 23, 45
exporting K-1 data 31
extensions 26, 45
Filing instructions 45
Filing Security Information screen 13
final returns
  updating 11
fiscal year returns 12
foreign
  tab 48
foreign ownership 29
FOREIGNUS 17, 31
Form 1120-C (U.S. Income Tax Return for Cooperative
  Associations) 11
Form 1120-H (U.S. Income Tax Return for Homeowners
  Associations) 11
Form 2220 (Underpayment of Estimated Tax By Corpora-
  tions) 23, 45
Form 3115 (Application for Change in Accounting Meth-
  od) 51–52
Form 3800
  Unsupported credits 22
Form 4466 (Corporation Application for Quick Refund of
  Overpayment of Estimated Tax) 23, 45
Form 4797 (Sales of Business Property) 16
Form 5884 (Work Opportunity Credit) 41
Form 6252 (Installment Sale Income) 16
Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)
  16, 41
Form 6765 (Credit for Increasing Research Activities) 41
Form 7004 (Application for Automatic Extension of Time
  to File) 26, 45
Form 8050 (Direct Deposit of Corporate Tax Refund) 24
Form 8820 (Orphan Drug Credit) 41
Form 8844 (Empowerment Zone and Renewal Community
  Credit) 41
Form 8845 (Indian Employment Credit) 41
Form 8846 (Credit for Employer Social Security and Medi-
  care Taxes Paid on Certain Employee Tips) 41
Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)
  16, 41
Form 8873 (Extraterritorial Income Exclusion) 21
Form 8881 (Credit for Small Employer Pension Plan Start-
  up Costs) 41
Form 8903 (Domestic Production Activities Deduction) 21
Form 8912 (Credit to Holders of Tax Credit Bonds) 41
Form 8932 (Credit for Employer Differential Wage Pay-
  ments) 41
Form 8941 (Credit for Small Employer Health Insurance
  Premiums) 41
Form 8941 (Credit for Small Employer Health-Insurance
  Premiums) 21

G
  gains and losses 16
  GBC screen 22
  General Business Credits 22
  gross receipts 14
  group sales 9

H
  header information 11
    Boxes A through E 13
  importing trial balance 53–62
  inactive returns 48
  income and deductions 14–21
  installment sales 9, 16
  instructions for filing 45
  insurance proceeds, income from 17
  interest
    expense 19
    income 16, 17
  inventory 14

L
  life insurance companies 40
  limitations
    meals and entertainment 21
    on NOL deductions 42

M
  M-2 out of balance, troubleshooting 39
  maintenance costs 18
  meals and entertainment 21
  Multi-State Apportionment 32

N
  net operating losses (NOL) 21, 41
  new features in Drake 9
  next-year depreciation listing 45

O
  officer compensation 17
  oil and gas depletion 20, 32
  ordinary gains and losses 16
  Other Costs line 5 14
  Other Deductions 21
  Other Income (Loss) 16
  out-of-balance M-2, troubleshooting 39
  overpayment, taxes 23
  ownership
    foreign 29
Index

P
parent-subsidary group 28, 40
PDF documents
e-filing 48–51
Pension and Profit-Sharing 21
percentage, stock and ownership 17
PIN (electronic) signatures 26
printing
statements for Schedule L 36
suppressing/forcing 44
prior-year returns, updating 10

R
receipts 14
references to forms and worksheets 45
refunds
direct deposit of 24
state tax 17
reject codes 46
rent paid on business property 18
rental & royalty income 16
repair costs 18
resident state 34
returns
consolidated 15
converting from another type 11
fiscal and calendar year 12
updating 10

S
Safe Harbor Elections 44
salaries 18
SCH2 screen (for Schedule L) 35
Schedule A (Cost of Goods Sold) 14–15, 37
Schedule B (Additional Information for M-3 Filers) 39
Schedule C (Dividends & Special Deductions) 15
Schedule E (Compensation of Officers) 45
Schedule G (Information on Certain Persons Owning the Corporation’s Voting Stock) 45
Schedule G (Schedule G (Information on Certain Persons Owning the Corporation’s Voting Stock)) 29
Schedule J total tax 22
Schedule K 28
Schedule K, line 13 30
Schedule K, line 3 28
Schedule K, line 4 29
Schedule K, line 5 29
Schedule K, line 7 29
Schedule K-1 30
Schedule L (Balance Sheet per Books) 34–37, 45
Schedule M-1 (Reconciliation of Books with Return) 37, 45
Schedule M-2 (Unappropriated Returned Earnings) 39, 45
Schedule M-3 (Reconciliation of Books with Return) 38
Schedule O (Consent Plan & Apportionment Schedule for a Controlled Group) 40
section
263A costs 14
481 17
security
business packages 13
security screen 13
short-year return 12
signatures, electronic (PIN) 26
signing the return 26
state
codes 32
contact information 32
information 12
multi-state apportionment 32–34
tax refunds 17
stock ownership 28–30

T
tax
alternative minimum (AMT) 40
and payments 22
-exempt interest 16
on fuels (credit for) 17
overpayment 23
-to-book difference 37
years (fiscal vs calendar) 12
taxes and licenses 19
trial balance import 15, 34, 36, 53–62
troubleshooting the M-2 39

U
underpayment of estimated tax 23
updating a prior-year return 10

V
vouchers 23

W
wages 18